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Various sections of this report rely on data supplied by or drawn from third party sources. HR Wallingford
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HR Wallingford will only accept responsibility for the use of its material in specific projects where it has been

engaged to advise upon a specific commission and given the opportunity to express a view on the reliability of the
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Summary

Minor Irrigation Design

DROP - Design Manual

Hydraulic Analysis and Design of Energy-dissipating Structures
J Skutch TDR

Project R 5830

Report OD/TN 86
June 1997

This manual and the accompanying DROP program were produced by the
Overseas Development Unit of HR Wallingford with funding from the UK
Overseas Development Administration, now DFID, as part of a continuing
programme of research into design and its impact on irrigation system
performance.

The package is principally aimed at the design of relatively low head structures, up
to 5 metres drop, for dissipating energy on surface irrigation schemes and for
locations below measuring weirs and flumes on open channels in water supply and
sewerage practice. The basic theory of energy dissipation in hydraulic jumps,
which is included in the manual and program, is also applicable to many high head
structures. However, other hydraulic phenomena, including cavitation and air
entrainment, become important in high head applications, whereas they have little
significance at low heads. Furthermore, a number of special types of energy-
dissipating devices, such as valves, ski-jump spillways, flip buckets and roller
buckets, have been developed for dealing with energy dissipation at medium/high
heads. Other guides are available for the selection and design of such structures. It
was therefore decided to limit the scope of the package to low head structures.

The program was produced under an informal working agreement between HR
Wallingford, the International Institute for Land Reclamation and Improvement
(ILRI), Wageningen and the Catholic University, Leuven (KUL) to make design
guides and software available to users all over the world.

The first part of the manual and program deal with the analysis involved in
interactive hydraulic design of various types of energy dissipating structures.
Principal hydraulic parameters such as specific energy, momentum, critical depth,
Froude number and the characteristics of hydraulic jumps, are calculated. The
package also deals briefly with problems of seepage under or around a structure.
Seepage and associated phenomena, such as uplift below a structure and washout
of soil material at the downstream end, may be an important determinant of the
overall structural dimensions.

The second part of the package presents selected type designs drawn from world
practice. In some cases, standardised ranges of structures to meet defined
hydraulic conditions are presented; otherwise empirical design equations are
available. Cost is obviously an important factor in the designer’s mind in the
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Summary continued

selection of a particular structure. However, other considerations will also play a
part. A flow chart has been prepared to assist in the selection of a type design,
which takes account of factors such as:

Ease of construction and the availability of construction materials
Performance in systems carrying sediment, debris or weeds
Ability to perform other functions such as bridging

Possible health hazards arising from ponded water

The package deals primarily with hydraulic design. Once the leading dimensions
have been established, the structural design of individual elements needs to be
addressed using good engineering practice for structures exposed to water.

A programmer’s manual for the DROP program is available separately
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1. INTRODUCTION

Energy dissipators will be required whenever and wherever the energy of flowing water exceeds some
threshold value above which unacceptable damage may occur in the downstream channel.

Dissipating structures are widely used in low head applications in irrigation, water supply and sewerage
practice, and are also necessary at dams, barrages and weirs in medium to high head applications.

This manual and the DROP program were produced at Wallingford, under the UK Technology
Development and Research Programme of the Overseas Development Administration (now DFID), to help
designers select and detail appropriate structures in low head applications. Typical applications will be the
dissipation of energy on irrigation schemes and in some applications in water supply and sewerage
practice. The package focuses on hydraulic aspects of design. Once the designer has obtained a
satisfactory outline design according to defined hydraulic conditions, it is expected that the design of
structural elements will proceed according to standard practice for structures exposed to water.

Energy-dissipation at medium to high heads is not dealt with in the package.

In such conditions it may be necessary to consider factors such as cavitation and air-entrainment, which do
not present a problem in low head applications. Whereas energy dissipation by means of the hydraulic
jump is often used in high head applications, particular types of devices, such as valves, flip-buckets, roller
buckets and ski-jump spillways, have also been developed. Other publications dealing with energy
dissipation in high head applications are available.

The manual and the program are structured in a similar way. The first part of each is devoted to the
hydraulics of energy dissipation, to help the designer determine whether proposed structures will be
hydraulically adequate and efficient. Design against seepage is also included (Section 3).

The second part of the package presents a range of standard structures drawn from world practice. In open
channel irrigation schemes, particularly where the ground slopes at over 1%, the cost of energy-dissipating
structures can add significantly to the total cost of the conveyance and distribution system. The designer
will therefore want to reduce as far as possible the number and unit cost of structures. Extensive tests in
many parts of the world have explored the potential for reducing the length of apron on hydraulic-jump
type energy dissipators, making use of devices such as baffle blocks, and cills (Section 4.2). Notably, the
St Anthony Falls (SAF) design incorporates a basin that is typically only 40% of the length of the
unimpeded hydraulic jump. Other types of hydraulic jump energy-dissipating structures are also included
in the package. Section 4.3 deals with straight drop structures, which are most often used on irrigation
schemes and in soil conservation programmes when the overall drop in head is commonly not more than 2
metres.

Section 4.4 deals with USBR type designs including a baffle to dissipate energy at the outlet of the
structure, and Section 4.5 deals with pipe drops. Section 4.6 includes various low head designs where
energy is dissipated at sudden expansions in the flow cross section. Regardless of which design is adopted,
it is almost certainly necessary to provide some additional, localised bed and bank protection downstream
of the structure to avoid scour damage in an unlined open channel system. Standardised recommendations
for protection are included in 4.6.

The manual includes a flow chart in Section 5 to help in selecting from the various existing type designs.
Apart from cost, which will obviously be an important factor in the designer’s mind, he/she may need to
consider factors such as:

e [Ease of construction and the availability of materials

e Performance in systems carrying sediment, debris and weeds
e Ability to perform other functions such as bridging
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e Possible health hazards arising from ponded water

A programmer’s manual for the DROP program is available separately.

2. THE HYDRAULICS OF ENERGY DISSIPATION

The concepts of energy and momentum derived from Newton's laws are basic to the dynamics of fluids.

2.1 Specific Energy

In free surface flow the pressure at any depth may be taken to be hydrostatic provided that:

1) Vertical curvatures and accelerations are negligible so that the streamlines do not curve.
2) The bed slope is small (Cosine of the angle approaching unity).

In these circumstances, the slope of the water surface is also the hydraulic grade line.

The general expression for the total energy H
H=y+z+Vv/2g (1)

where:
y is the vertical distance from the bed to the water surface
z is the height of the bed above some datum
v is the velocity of flow

gives rise to the definition of Specific Energy, E, which is the energy of flow referred to the channel bed as
datum:

E=y+v'/2g (2)

And for a rectangular channel:

2

q
E=y+ 3
y 20 3)

where:
q is the discharge per unit width of channel.

Both of these expressions involve a cubic in y, but only two of the roots are real. The third being negative,
is of no practical interest. The two possible values for y are the Alternate Depths. The Specific Energy
function is plotted in Figure 1(a). One of the solutions will lie on the upper limb of the graph (subcritical
flow -typically slow and deep); the other, representing supercritical flow which is typically fast and
shallow, will fall on the lower limb.

For a non-rectangular channel section Equation 2 can be rewritten to incorporate a mean channel velocity
derived from the total discharge, Q, and the total cross sectional area, A:

QZ
2g4*

E =y+ )
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2.2 Momentum
Newton’s law gives:

Ft=m(v, - v,) )

where:
Ft = the force acting over time t
m = the mass of the body
v = the initial velocity
v, = the final velocity

Otherwise stated, the impulse applied to a body is equal to the momentum acquired by it. This holds true
for a fluid as for a solid body, provided that proper allowance is taken of all the forces acting. Momentum
and force are interchangeable but there is no net loss to the system.

Equation 5 can be reformulated for a channel of rectangular cross section in terms of momentum per unit
width of channel:

S Fgp 2 v ©

where:
p = fluid density

The driving and restraining forces imposed by surrounding fluid on the mass of fluid contained between
sections 1 and 2 are

2 2
P g P2

2

assuming a hydrostatic pressure distribution. Any other forces acting, such as the reaction of sidewalls and
bed sills may be grouped and termed P.

Then
2 2

P P

2= _P=gpv, —qgpv
> > qp v, —4pv

Rearranging gives:
Plp=M,-M,
where M, and M, are the momentum functions at section 1 and 2 respectively.

The general form M for a channel of rectangular cross section is :

2

y
M = +— 7
5 (7

7
gy

A HR Wallingford 3 OD/TN 86 01/07/02 11:43



A non-dimensional form of the momentum function is plotted in Figure 1(b).

For a non-rectangular cross section, the channel must be treated as a whole:

2 _
Mng—A+Ay (®)

where:
A y =moment of area of section about the surface

2.3 Critical Depth and Froude Number

Section 2.1 and Figure 1(a) showed that for any given pair of values of specific energy and unit discharge
there are two possible depths of flow, one in the supercritical and the other in the sub-critical state. The
depth corresponding to the point on the graph, C, where the specific energy is a minimum for a given unit
discharge, is defined as the critical depth. It can be shown by differentiating Equation 3 that in this
condition:

v =gy, 9)
y. =2/3E, (10)

Also, for a rectangular section channel,

v.=3q’/g (11)

where
v, = velocity in critical conditions
y. = depth in critical conditions
and E. = specific energy in critical conditions

To summarise, in critical flow:

e specific energy is a minimum for a given flow rate. The depth of flow equals 2/3 of the specific
energy
o for a given specific energy, discharge is a maximum

It can also be shown from Equation 9 that in critical conditions, flow is travelling at a rate exactly equal to
that at which a surge wave of small amplitude would move through still water. The Froude Number, Fr, is
defined as the ratio of flow velocity to wave velocity. Thus it follows:

Velocity of flow State of flow Froude Number(Fr)
Ve <(gy) Subcritical <1
Ve="(gy) Critical )

Ve >V(gy) Supercritical >1

where, for a rectangular cross section:
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Fr=v/\gy (12)

For a non-rectangular channel section, the conditions for critical flow can be derived by differentiating
Equation (2), using the total discharge, Q, and the total cross sectional area, A, thus:

T =g A (13)
and the Froude Number is given by:

Fr’=0T/g 4° (14)

where:
T = water surface width

When the Froude number = 1 (critical flow) it will be seen that Equation (14) reduces to the expression in

(13).
2.4 The Hydraulic Jump

241 General

A hydraulic jump is a sudden and turbulent change in flow from a low stage below critical depth to the
conjugate depth above critical whilst the velocity changes from supercritical to sub-critical. During the
course of this transition considerable energy is dissipated, principally in turbulence.

The geometry and characteristics of the hydraulic jump vary considerably depending on the incoming flow
conditions and the tailwater depth. Hydraulic jumps on a horizontal floor are of several distinct types.
According to the USBR they can be classified according to the Froude number of the incoming flow as
follows:

Froude Number Jump Characteristics
1.0-1.7 Surface waves (Undular)
1.7-2.5 Weak jump. Low energy loss
2.5-4.5 Oscillating jump. Large irregular waves.
45-9.0 Steady jump
>9.0 Strong jump

Figure 2 shows these various types of jump in outline.

There are three parameters of the jump that are of principal importance to the design of energy-dissipating
structures:

e The ratio of the incoming depth to the sequent (post jump) depth
eThe magnitude of the energy loss for any given set of incoming flow conditions
e The length of the jump

2.4.2 Rectangular channels

Supercritical flow will jump to subcritical if the downstream tailwater depth equals the conjugate or
sequent depth and so provides the necessary hydraulic resisting force. The specific energy equation cannot
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be applied initially since there is a loss of energy across the jump. Applying the momentum equation to
the case of a rectangular channel and equating forces, the required sequent depth is given by the equation:

v ly =", (1/1 +8 Fr? —1) (15)

Results of this equation are plotted in Figure 3(a).

Energy Loss

For a rectangular channel, the energy loss is given by the expression:
E=E -E,=—— (16)

or

E=y, (\/1+8Fr2 —3) / 16(\/1+8Fr2 —1) (17)

Figure 3(b) shows the variation of energy loss, as a percentage of total incoming energy, with Froude
Number.

Length of Jump

There are various interpretations of the end of the jump. It has been defined either as the point where the
reverse surface roller ends or the point of maximum water depth. Results for the case of the rectangular
channel section, due to USBR, are shown in Figure 3(c).

2.4.3 Non-Rectangular Channels
Depth Ratio

In prismatic (non-rectangular section channels) the general expression is:

A° A
Ak, v, — Ak y, =| Fr* 2— 1-= 18
b Ky Vo 1 K\ N ( T J [ Azj (18)

where:
kyy; is the depth to the centre of pressure upstream

koy» is the depth to the centre of pressure downstream

To solve the equation, the upstream and downstream areas A; and A, and the channel top width T need to
be expressed in terms of the channel depths y, and y,.

Channel section Area Centre of Pressure Top width
Parabolic AVA; = (yilyy) 7 ki=k,=04 Al/T1 =2y,
Triangular AVA; = (yilya) k =k, =0.33 Al/T=y,
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Results are shown in Figure 4(a)

The result for a trapezoidal channel is given by Massey (1961) as:

x4+{£+1}x3+[3—K+1} [K +1] x> + (3—K+le— A x—f=0 (19)
2 2 2 (K+1
where
X=y2/yi
K=b/my, m = side slope, b = channel bed width
_ 30
/= 2 5
gm  »

Figure 4(b)shows the depth ratio for jumps in trapezoidal and circular channels.

Energy Loss

For non-rectangular channel sections the energy loss is given by the general expression:
Eo/El = (E;-Ey) / E; = (2 (1 +yy/y)) + Fr* (1 — (A, /A,)? / 2+ Fr) (20)

Results in Figure 5 are for a rectangular section compared with parabolic and triangular sections, and in
Figure 6 for circular and trapezoidal sections.

The expressions for individual channel sections are very complex and are not presented here.

The results are based on small-scale laboratory tests and are indicative only.

Jump length

The jump length in prismatic channels is not well-documented. Figure 7 shows what is believed to be the
best information available for triangular, parabolic, trapezoidal and circular channels.

Particularly in triangular and trapezoidal-shaped channels there may be a tendency for the flow to
concentrate in the centre of the channel. Flow is therefore non-uniform so theoretical predictions may not
accurately describe the jump in practice.

2.4.4 Jump Rating Curves

If the tailwater is deeper than the sequent depth required to form a jump corresponding to the incoming
flow conditions, the jump will be submerged or drowned. A large reverse surface eddy will be created
above the jet. With increasing submergence the efficiency of energy dissipation is reduced. Quantitative
data on the relationship are not readily available. Deepening the tailwater excessively by, for example,
lowering the level of the structure apron is not hydraulically efficient, though it might be required if there
is considerable uncertainty as to the stability of the tailwater channel.

In design, the jump rating curve defining the sequent depth throughout the flow range and the tailwater

rating curve indicating the tailwater depth at the same flow increments, need to be compared. Leliavsky
(1979) defined five cases, shown in Figure 8.
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Class 1 Ideal conditions in which the two rating curves always coincide. Such conditions are
rarely encountered in practice.

Class 2 Conditions in which the jump rating curve is always at a higher stage than the tailwater rating
curve. This means that the jump will sweep downstream unless effective measures are taken (deepening
the basin, constructing sills).

Class 3 Conditions in which the tailwater rating curve is always higher than the jump rating curve. The
jump is forced upstream and will probably be drowned out. To ensure a jump, the downstream channel
bed needs to be dropped relative to the structure or a sloping apron can be constructed. These may not be
practical options. It may be necessary to accept that the structure is going to be less effective than
desirable and protect the downstream channel accordingly.

Class 4 The jump rating curve is higher than the tailwater rating curve at low discharges but lower at high
discharges. One option is to provide a stilling basin for low discharges and a sloping apron for high
discharges.

Class 5 The jump rating curve is lower than the tailwater at low discharges but higher at high discharges.
The stilling basin design is governed by conditions at maximum discharge.

2.4.5 Jumps in Channels of Varying Cross Section

The formation of the jump on a sloping channel floor is beyond the scope of the present manual. There are
advantages in hydraulic terms, as the jump becomes more stable, although it is less practical to construct
the apron.

In a gradually expanding channel the jump position is localised but its efficiency may be lower. The jump
forms part of a radial jump.

A spatial jump can be promoted by abruptly expanding the channel section. The jump position is very
stable. References shown in the bibliography (Ven Te Chow, 1959), (USBR 1974) cover the
characteristics of jumps in these conditions.

2.5 Turbulent Shear, Scour and Effect on Tailwater

The erosive forces on a channel surface in uniform, turbulent flow occur within a developed boundary
layer. Surface particles will be removed when the disturbing forces exceed the resisting forces. The
tractive force theory of channel design is based on this concept.

When a jump is formed in the transition from supercritical to subcritical flow, a large amount of energy is
dissipated within the fluid in the form of turbulent eddies. Turbulent shear is at a maximum along planes
of flow separation where a jet of rapidly-moving fluid flows through fluid at rest. Turbulent eddies, driven
by the jet, transfer momentum across the boundary between the two regions. If the shear plane comes in
contact with an erodable boundary the potential for damage is considerable. The aim in design is to direct
the jet and protect the boundary until most of the surplus energy has been lost within the fluid body. The
development of scour holes below hydraulic structures, see Section 4.6, is a result of high turbulence
generated by an emerging jet. In clear water flow, the scour hole will continue to develop until the
dynamic and turbulent forces are resisted by the inertial forces. Figure 9 shows the plan view of an
emerging jet at an abrupt exit. Slow -moving reverse circulation currents are created on either side of the
jet. They will tend to return eroded material towards the point of emergence of the jet, whilst within the
developing scour hole reverse eddy currents below the jet will similarly move material locally towards the
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structure. Provided the jet flows clear of the downstream channel surface, the large slow-moving reverse
circulations in the horizontal plane are unlikely to prove destructive.

As indicated in Section 2.4.2, the usual definitions of the end of a jump are based on visible characteristics
like the downstream end of the surface roller or the establishment of a constant depth of flow. In practice,
residual turbulent energy is contained in eddies which may persist for a considerable way downstream of
the jump. It is therefore normal in unlined earth canals to provide additional surface protection beyond the
end of the protection offered by a solid structure. If it is proposed to use a structure shorter than the full
jump length it is particularly important to protect against residual turbulent energy in the flow. Section 4.6
refers to structures without solid boundaries which are designed to exploit the capacity of water to dissipate
energy within its mass. Where a structure is to be sited in a natural channel, there is a strong possibility
that the channel bed may either erode or aggrade, thus affecting the tailwater and the performance of the
structure. Under natural conditions the beds of many streams are scoured during the rising stage of a flood
and filled during the falling stage. If the water is clear as the result of artificial removal of sediment, either
by the structure itself or by another upstream, material scoured from the bed will not be replaced by natural
deposition so that gradual retrogression of the whole downstream riverbed may occur. The tailwater stage-
discharge relationship will therefore change. Appropriate allowances must be made by the designer
(Section 2.4.4).

3. SEEPAGE

3.1 General

The need to provide adequate resistance to seepage both under and around a hydraulic structure may be an
important determinant of its geometry.

The boundary between a structural surface and foundation soil or backfill represents a potential plane of
weakness, particularly along the back of earth retaining walls and around cut-offs. Good compaction of
soil during construction is vital.

Uncontrolled seepage can promote the following types of failure:

e Piping through soil subjected to an excessive overall hydraulic pressure gradient that causes soil
particles to be dislodged from the matrix. Progressive undermining of the structure and effective
failure may result.

e 'Boiling' of the subsoil at the exit from a structure caused by a local excess pressure gradient.
Under submerged conditions the density of most soils will be only about 50% of the un-submerged
bulk density. The seepage hydraulic pressure will be directed vertically upwards at emergence.
The combined effect may be to lift out soil particles and undermine the structure from the
downstream end.

e Uplift of the whole or parts of the structure by the underlying hydraulic pressure in the soil.
Figure 10 is a schematic of a structure subject to seepage.

Stability under a given hydraulic head could in theory be achieved by an almost limitless combination of
vertical and horizontal contact surfaces below the structure provided that the total length of the resultant
seepage path were adequately long for that head. In practical terms, the designer must decide on an
appropriate balance between the length of the horizontal elements (H) and the vertical ones (V) in order to
arrive at an economic design for a particular type of soil. Design practice prevailing in a particular country
or region may effectively dictate the balance. Optimisation based on knowledge of local construction costs
would be possible but is rarely attempted.
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Leliavsky, (1979) quotes the following average figures for different parts of the world:

Region Egypt Europe North
America
Ratio of lengths 1/3.5 1/2.5 1/1.0
V/H

Particularly in the case of small structures, of which large numbers may need to be constructed, the
designer will be constrained by economic pressure to keep the structure as short as possible. In this case
hydraulic requirements will probably have the determining effect on the horizontal length. The length of
the vertical cut-offs, especially the downstream one, will then be determined by the requirements for
seepage resistance.

Figure 11, reproduced from Leliavsky, illustrates the relative effectiveness of horizontal and vertical
elements in various combinations, all of which provide the calculated exit gradient of 1/11 for a particular
structure (Assiut Barrage). In this figure the dimensions of the downstream cut-off, which is the principal
vertical element providing protection against piping, are varied. The depth of the upstream cut-off remains
constant throughout. At a head of 5 metres, the factor of safety would be achieved with piling 10 metres
long and floor 54 metres long. A four metres long pile would require a floor length of 140 metres, and so
on.

Scour of the downstream channel may expose a cut-off that is insufficiently deep, particularly at structures
sited on alluvial rivers. In such situations it is common practice to ensure that the depth of the downstream

cut-off is at least equal to the depth of flow in the channel (normal scour depth).

NOTICE: upstream and downstream cut-offs must be carried across the full width of the structure, ie main
body and wingwalls, otherwise a shorter seepage path will exist along the outside face of the sidewalls.

3.2 Analysis

For large structures it may be practicable to conduct seepage analysis using:

a) Flow nets constructed by trial and error or graphical methods

b) Electrical analogues

¢) Mathematical solutions of the Laplace equation
However, simplified and empirical methods are commonly used in the routine design of low- to medium-
head structures. Lane’s Weighted Creep Theory, and Khosla's Method of Independent Variables, are most
commonly adopted (Varshney et al, 1977).
Lane's Theory was based on the statistical examination of a large number of structures on pervious
foundations. The method incorporates an assumption that the resistance to flow through the soil, and
therefore the rate of pressure drop, will be three times higher in the vertical than in the horizontal direction.
One explanation put forward is that horizontal layering in the soil provides an easier passage to seepage.

In Lane's Method, vertical structural surfaces are weighted so that they become three times as effective in
reducing seepage pressure as horizontal ones.

Ly == +V @1

L, >CH (22)
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where:
Lw = effective seepage length
N =Y (all horizontal contact lengths and contacts sloping <45°)
V =Y (all vertical contacts and contacts sloping > 45°)
C = factor depending on soil
H = difference in water levels

Analysis of the performance of established structures suggests that the relative permeability of foundation
soil in the vertical and horizontal directions varies widely.

Safe values for the overall weighted seepage gradient in different soils according to Lane:

Table 1 Values of Lane's Safe Weighted Creep Ratio, C

Soil Cvalue

Very fine sand or silt 8.5

Fine sand 7.0

Coarse sand 5.0
Gravel and sand 3.0-3.5
Boulders, gravel and sand 2.5-3.0
Clayey soils 1.6-3.0

Lane's Theory is simple and rapid to apply so it is convenient for making quick preliminary analyses of a
structure's overall resistance to seepage.

However, the method does not provide any check against the danger of excessive pressure gradients
developing locally at the downstream end of the structure. It also appears to imply that a vertical cut-off
would be equally effective whether located at the upstream or downstream end of a structure. More
detailed analytical methods show this is not the case.

Under Khosla's Method, a composite structure is split up into a number of simple standard forms, each of
which has a known solution. The pressures at key points corresponding to each elementary form are
calculated on the assumption that each form exists independently. The various forms are superposed and
corrections to the pressures are made to allow for the interaction of each form with the others. An explicit
check is made for the stability of the soil at the exit from the structure (exit gradient). Appropriate factors
of safety to ensure stability in different types of soil are incorporated in the Safe Exit Gradients determined
by Khosla.

Table 2 Safe Exit Gradients for Different Soils

Soil Type Safe Exit Gradient
Shingle 1/4 to 1/5
Coarse sand 1/5to 1/6
Fine sand 1/6 to 1/7

The possibility of piping at exit is usually further reduced by providing an inverted filter below the
downstream bed protection. It is common practice to assume that the effective seepage resistance presented
by the exit face of the downstream cut-off is reduced by the thickness of the protection layer plus the filter.
It is conservative to assume that the downstream channel is empty, the filter layer is dried out and the
pressure at its underside is atmospheric for one of the determining design conditions in both free surface
and sub-surface flow.
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4. ENERGY DISSIPATING STRUCTURES - STANDARD DESIGNS

4.1 General

A very large number of designs for low- to medium-head energy-dissipating structures exist in the world.
Most countries have their own type designs. However, the vast majority of such structures fall into one of
three basic categories:

e Straight drops
e Inclined drops with a stilling basin to contain the hydraulic jump
e Impact-type dissipators

For convenience, pipe drop structures are described separately in Section 4.5, although in practice they rely
for energy dissipation on one or other of the three basic types above.

Lateral and/or vertical flow expansion allows dissipation of energy by turbulence within the water mass.
The mechanism involved is similar to that in straight drop and hydraulic jump basin structures. The
difference is that the designer aims to remove the zone of turbulence from the structural boundary. It is for
this reason that flow expansion structures are referred to separately in Section 4.6 together with channel
protection.

The structures included in DROP as particular examples of the general types are considered to give a
reasonable cross section of world practice. They are drawn from published literature listed in the
bibliography. Outline information on the structures' hydraulic capabilities and limitations are included
here. The design rules, or graphs, or tables of dimensions are included in the Standard Design module of
DROP but for further details of the design, reference should be made to the source literature. Those design
rules for individual structures which are included here, and within the program, are supported by lengthy
empirical verification, or detailed laboratory testing, or both. It will be apparent that no attempt has been
made to provide a fully comprehensive guide to national designs.

'Small' structures are taken to be designs of the size and type included in the FAO (1976) and USBR
(1974) publications on small irrigation structures. However, designs termed 'Farm level structures' are
beyond the scope of the present manual. FAO Irrigation and Drainage publication 26/2 provides details of
such structures.

Devices such as valves, ski-jump spillways, flip buckets, roller buckets and others which are frequently
used to dissipate energy below large dams, are also not included here.

In the case of medium to high head spillways, surface friction plays a significant role in reducing the
energy of flow entering the dissipating structure. However, for low head structures (upto 5 metres lead)
which are the concern of this manual, friction can be assumed to have little effect on the hydraulics of the
system.

The Froude Number of flow at entry to the stilling basin is a principal criterion for selecting from amongst
the various standard structure types, such as those of the USBR. In the case of low head structures,
calculation of the Froude Number becomes relatively straightforward (see Section 2.3).

As indicated in Section 2.4.1 and Figure 2 the characteristics of the hydraulic jump vary at different Froude
Numbers. Structures outlined in the following section are designed to operate within ranges broadly
defined in Figure 2. Apart from the small canal drop structures in Section 4.3.3, the stilling basins are all
rectangular in cross section. Tests conducted by the USBR indicated that the hydraulic jump that forms in
a trapezoidal-sectioned basin is less complete and less stable than that in a rectangular section. Therefore
the sidewalls are designed to be vertical, which also makes for simplicity in construction.
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4.2 Stilling basins

4.2.1 USBR Standard Structure Types

The various standard structure types are summarised in Figure 12, with the range of Froude Numbers for
which they are applicable. Brief descriptions of the structures are included in the following sections.

Typel

Structure I consists of an horizontal apron without blocks or end sill (appurtenances). The basin is suited
to incoming flows characterised by a Froude Number in the range 1.7 and 2.5 ("pre-jump' conditions). The
structure is not commonly used as it tends to be uneconomically long and the hydraulic jump can also
sweep out at tailwaters only marginally below the design level.

Type I

Structure II is suited to high velocity flows with Froude numbers above 4.5, conditions occurring typically
below high spillways, and it is therefore not considered here in detail. The jump length is reduced over the
unrestrained case by around 33% through the introduction of chute blocks and a dentated end sill.
Sweepout of the jump can be a problem so the USBR recommends that the apron level is fixed assuming
that the tailwater depth is 5% less than expected.

Type III

The structure (Figure 13) is suited to locations where the Froude number exceeds 4.5, the incoming
velocity does not exceed 15 m/s and the discharge intensity is less than 18 m’/s per metre width. The
restriction is imposed to avoid cavitation damage to baffle blocks, chute blocks and the solid end sill which
are fundamental to the design of the structure.

Introduction of these appurtenances shortens the jump and the basin by about 60 percent over the
comparable Type I structure.

The structure is suited to lower head conditions small spillways, outlet works and canal structures.
Structure IV

Structure Type IV (Figure 14) is intended for Froude Numbers in the range 2.5-4.5 (‘Transition jump with
rough surface' in Figure 2), conditions which may typically occur at small drops in open channel systems.
The design is intended to reduce the generation of surface waves which can travel large distances
downstream and erode canal banks. For this reason the chute blocks are enlarged in order to direct the

incoming jet into the base of the jump roller to help stabilise it.

For situations where it is essential to minimise surface turbulence, the USBR has also developed designs
for surface wave suppressors which can be placed downstream of the main structure.

The Slotted Grating Dissipater

The slotted grating dissipater (shown in Figure 15) was devised as an alternative to the Type IV structure.
It is therefore included here, although it is not a conventional hydraulic jump basin device. The
overflowing nappe is split up by the bars of the grating so that individual filaments of flow fall nearly
vertically into the basin where excess energy is dissipated in turbulence. The grating must be long enough
to include the trajectory of the jet under conditions of maximum flow.
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The following experimental relationship, which has been converted to metric units from the original
imperial form, gives an effective design:

0
Lg= 23
# 0.83w N y2gH 29

where:
Lg = length of grating (m)
w = width between bars (m)
N = number of bars
and other symbols have their usual meaning.

Structure Type V

The Type V structure is designed to provide effective performance when the jump sequent depth and the
tailwater cannot be matched across the full range of flow conditions. (Section 2.4.4). A sloping apron
allows the jump to form at different points, depending on the discharge. This solution is not often adopted
for small structures, probably because it is less simple to construct than a horizontal apron.

4.2.2 Indian Standard Structures
IS Type I

This structure is an alternative to the USBR Type IV basin for Froude Numbers in the range

2-4.5. The apron is shorter than the equivalent USBR structure but it is achieved using a more complex
end sill and an extra set of baffles. The structure is also only partially effective in reducing downstream
surface turbulence. It appears to have no clear technical advantage over its USBR equivalent and the
overall cost is likely to be similar.

IS Type II

The structure is intended for Froude Numbers above 4.5, high velocities (15m/s and above), and is an
alternative to the USBR Type II basin for medium to high heads. For given conditions the structure
appears to be longer than the US structure. It is not considered in further detail here.

IS Types III and IV

Alternatives to the USBR Type V sloping apron structure, to which they are similar in many respects. The
IS Type III structure is indicated when the available tailwater depth is greater than the sequent depth
throughout the range of discharges. The IS Type IV is for use when the tailwater exceeds the sequent
depth at maximum discharge but the two are similar at lower discharges. They are not considered in
further detail here.

4.2.3 SAF Stilling Basin

This small structure design was developed at the Saint Anthony Falls laboratory of the University of
Minnesota, Blaisdell (1948). The aim was to design an energy-dissipating structure with the minimal
practical basin length, suitable to a wide range of tailwater conditions and Froude numbers.

Figure 16 shows the dimensioning of the structure for a range of Froude numbers between 1.7 and 17.
The structure can produce reductions of up to 40% on the length of a simple apron structure and 40% on

the calculated sequent tailwater depth. The penalty is that construction becomes somewhat more complex.
An endsill, chute blocks (to split the incoming jet and increase its depth), and baffle blocks (to absorb
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momentum and generate turbulence) are included in the design. Transported debris is liable to become
lodged in the basin. The required tailwater depth for satisfactory performance across the range of Froude
Numbers was determined from tests (Varshney et al, 1977).

Tailwater depth: Basin length
2

/ Fr 4.5

D, :(I.IO—E) D, For F.=1.71t05.5 WJDZ
/ 4.5

D2 =0.85 D2 F; =551l Wj D2
/ 2 4.5

D, =(1.00 — Fr*/800) D, F =11t017 07 D,

where:

D, is the required tailwater depth above the stilling basin floor
D, is the calculated sequent depth

4.2.4 Small Inclined Drop Structures

Small structures in both reinforced concrete and masonry are included in FAO pub 26/2 “Small Hydraulic
Structures” (1976).

USBR Rectangular Inclined Drop

The structure includes chute blocks and baffle blocks. It is suitable for drops from 0.9 metres to 4.5 metres
and discharges between 0.14 m®/s and 2.8 m’/s. The inlet velocity is limited to 0.90 m/s.

Indicative details are included in Figure 17 which is taken from the USBR 'Design of Small Canal
Structures.' A pool (basin) length of 4 times yp on Figure 17 (sequent depth) is required when the structure
is used in conveyance canals, whereas for wasteways and drains, where the flow will be intermittent and of
short duration, a length of 3yp may be used.

Over 100 standard structures are fully dimensioned and detailed in FAO pub 26/2 for applications in
irrigation canals. A similar range is available for drains.

Provided the apron level is set correctly and the design tailwater is maintained, problems of downstream
erosion are rare in irrigation applications. Where a minimum tailwater cannot be assured, a weir should be

built into the exit of the basin.

The structures should be safe against seepage and sliding on normal soils. However, on highly permeable
soils the total structure length will need to be checked to ensure adequate resistance to percolation.

Masonry Falls
There are many variants on the basic designs. In India the structures are termed glacis falls.
The Central Water and Power Laboratory in India has not imposed definite limits to the use of its Standing

Wave Flume. It appears suitable for drops of at least 4 metres and discharges of 3m’/s. The structure is
also designed to measure flows. Design formulae are included in FAO 26/2.
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4.3 Straight Drop Structures

4.3.1 USSCS/USBR Structure with Impact Blocks

The structure (Figure 18) was devised by the USSCS and is used by the USBR. The developers were
Donelly and Blaisdell (1965) who conducted extensive tests after earlier Morris and Johnson structures
(1942) had given inadequate performance in erodable, sandy clay soil. The structure is particularly suited
to a wide range of downstream tailwater levels, conditions that are typical of gullies and natural
watercourses.

The dissipation of energy by turbulence in the basin is assisted by impact blocks which also remove force
from the jet.

Contrary to the findings in the 1942 design, which included longitudinal sills in the stilling basin as a
means of directing the jump and reducing downstream bank scour, it was found that sills neither
significantly improved nor worsened the hydraulic performance of the structure. They are therefore not
included in the standard 1965 design though they could provide added structural strength to the basin floor
if needed. The USSCS and USBR designs, although substantially the same, differ in detail. In particular,
the USBR provides a crest at the control section so that the nappe is always aerated. The aim is to avoid
the development of low pressure below the jet which would cause the nappe to cling to the dropwall. A
variety of crest shapes may be used: sharp for a fully contracted jet, broad for a fully suppressed jet or
shaped to achieve a higher discharge coefficient.

The design procedure involves rules developed during testing when it was found that dangerous scour
could develop in the downstream channel if the tailwater rose above a certain minimum level. In this case
the nappe was lifted by the downstream water mass so that it landed beyond the end of the basin. The
revised basin design is intended to guard against the occurrence of such a condition.

The USSCS requires that the crest of the structure is set level with the upstream bed. No special provision
is made for ventilation of the nappe. The approach channel needs to be designed so that a tendency for the
jet to contract at entry to the structure is suppressed.

Despite differences at the control section the overall size of the USBR and USSCS structures for a given
set of conditions appears to be the same. Figure 18 shows the leading dimensions of the structure.

The minimum length of the basin, Ly = X, + 2.55d, (24)
where:
X, = distance of impact of jet on basin floor from dropwall
d. = critical depth at the crest for the design discharge.
The raised crest of the USBR structure appears to be a disadvantage in systems where the water carries
high sediment loads. Despite local high velocities at the weir, deposited material is likely to accumulate
for some way upstream. The side effects could include a slight reduction in the discharge coefficient.
A minimum tailwater depth, given by:
dw = 2.15d, (25)
is required to ensure that the flow leaving the basin does not plunge and scour a hole in the downstream

channel bed. The impact blocks need to be located a minimum distance of 1.75d. upstream from the end
sill to ensure that both function effectively.
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The USSCS/USBR do not appear to impose explicit limitations on the maximum discharge nor the
tailwater level. The maximum drop height is stated to be 6 metres, though in canal practice a limit of about
2 metres would be normal. The concentrated forces resulting from the impact of the jet on the basin floor
make it imperative to ensure good foundations. It is suggested that the designer checks that the prevailing
tailwater level approximates the required sequent depths at design discharge.

4.3.2 USBR Structure without Impact Blocks

As for the basin with impact blocks, the design procedure is intended to allow for the possibility of a high
tailwater lifting the overflowing nappe over the basin. The design should ensure that the hydraulic jump,
which should develop downstream of the point of impact of the jet on the floor, is contained within the
length of the basin. The resulting design is likely to be significantly longer than, and relatively
uneconomic compared with, the previous structure. However, it is possible to use the design with a wider
range of foundation materials because the hydraulic forces on the slab are apparently lower.

An alternative structure is likely to be more suitable in most circumstances. For larger drops the USBR
Type III basin or, possibly, the straight drop with impact blocks where foundations are good, can be
considered. For small drops the standard straight drop structures referred to in the following section may
be appropriate.

4.3.3 Small Drop Structures - FAO

The structures included in FAO 26/2 are drawn from national practices around the world. Straight drop
structures from Indian, French, US, and Japanese practice are included. Principal differences lie in the
material of construction.

Two are discussed in this manual. The Sarda Fall from North India is an example of a masonry structure
and the USBR drop structure with trapezoidal downstream cross section represents reinforced concrete
practice.

Sarda Fall

The Sarda Fall (Figure 19) is widely used in the sub-continent. Although it is supposed to be capable of
passing discharges of up to 15 m’/s in its basic form, and higher flows with a more substantial headwall, it
is most commonly used for small flows and drops. The structure generally performs reasonably
satisfactorily but it is also not uncommon to find erosion developing in the channel immediately
downstream of the protected length. It is therefore advisable to consider providing extra protection in the
form, for example, of a flow expansion (Section 4.6) below the standard design.

USBR Check Drop

Details of the check drop (Figure 20, 21) are based on USBR “Design of Small Canal Structures” (1974).
The structure is of reinforced concrete with slab thickness generally of 150 mm. The maximum fall in an
unlined canal is 0.9 metres (3 feet) for flows up to 2m*/s and 0.46 m for flows of less than 3.0 m’/s.
Although they have been used for drops of up to 2.4 metres in lined canals, seepage, impact forces and
structural stability may impose strict limits on their wider use.

There is a standard range consisting of over 20 structures for the smaller drop size and there are eight
structures with a 0.9 metre drop.

The structure incorporates a trapezoidal section stilling basin which requires a good standard of
construction to ensure proper compaction below the sides. Long downstream wing walls are not needed.
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4.4 Impact devices: Baffled Structures
USBR Impact Type (vertical baffle) basins

This type of structure (Figure 22) depends on removing force from the water by opposing the emerging jet
with a baffle. Energy is dissipated in turbulence generated after the impact.

A minimum tailwater depth is not required to obtain satisfactory operation, so the structure is particularly
useful in systems where the discharge builds up rapidly and the tailwater responds slowly. However, it is
preferable if the downstream water depth is at the mid-height of the baffle so as to minimise a tendency to
generate surface waves that are potentially damaging to the channel. The baffle should never be
submerged by tailwater, and should be set with its lower face level with the invert of the upstream channel
or pipe.

A standard range of sizes is available.
Selection of the appropriate structure is made on the basis of the Froude Number of the incoming jet.

To avoid cavitation-induced damage the velocity at inlet should never exceed about 15m/s, which
corresponds in theory to a sudden drop in level of over 11 metres, a situation which might be encountered
at a small reservoir outlet, though not commonly within an open channel system. In practice, the diameter
of the incoming pipe should be sized on the basis of a design velocity of 3.5 m/s flowing full.

Under higher heads the basin is subjected to large dynamic forces which must be considered in structural
design. The structure must be stable against sliding forces generated by the impact of the jet on the baffle.
The whole structure must resist hydraulically-induced vibration and individual members must resist high
dynamic loadings.

An air vent should be provided to help to reduce instability if the pipe entrance is likely to be submerged
and a jump is able to form within its length. Sediment may accumulate in the basin during periods of low
flow. Notches are provided in the baffle to generate localised jets which can assist in washing sediment
clear of the basin. However, the structure is not suited to systems where there is a heavy burden of
transported debris since there is no practical way of making the basin self-cleaning.

The structure was developed for situations where a substantial tailwater cannot be relied upon, for example
in systems where gates and syphons generate a sudden increase in the incoming flow or in areas of the
world where natural watercourses are subject to flash flooding. It was primarily intended for use with pipe
and culvert outlets but is also used frequently at the outlet of pipe drops on irrigation systems. It can also
perform satisfactorily in open channels with modifications at the inlet.

Single basins have been used with discharges up to 11 m’/s. For larger discharges, numbers of basins can
be placed side by side.

The USBR states that a properly-designed structure is more effective than a hydraulic jump dissipater.

USBR Baffled Spillway

In irrigation practice, the baffled spillway (Figure 23) is usually used as an intermediate or tail escape on
canal systems. It is also used with drainage structures, being particularly appropriate where the tailwater
cannot be assured and an inclined drop (Section 4.2.4) is not suitable.

The gradient of the chute is normally 2:1 or flatter.
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It should not be used in systems where there is a lot of transported debris. It may be necessary on some
systems to clean away weeds that become lodged around the blocks.

There is no explicit restriction on height of drop but the structure becomes uneconomical for large flows
with large drops owing to the width and number of blocks required. Structures with unit discharge
capacities in the range 0.90 - 7.5 m*/m width have been constructed.

It is important to note that in a structure of this type, which could be applied in a very broad range of
conditions, the hydraulic design may not be the ultimate determinant of the overall structural layout. The
stability of the foundations, resistance to seepage, uplift pressures and potential for erosion require to be
carefully checked.

4.5 Pipe drops

Pipe drop structures are considered separately from the three broad categories of structure defined in
Section 4.1 because the pipe is itself a conveyance structure for which the necessary dissipation of energy
may be achieved by any one of the three methods: a straight drop at entry, a hydraulic jump or a vertical
baffle at outlet. The basic principles of each of these types have been described. Outline details of two
typical pipe drop structures are included here.

Pipe drops provide an attractive and economical solution if frequent road crossings for access, operation
and maintenance must be provided over the canal or waterway. Pipes are usually of pre-cast concrete.

Unless strict construction supervision is applied, joint failures can occur, particularly where mortared joints
are used and the pipes are subject to settlement.

The structures illustrated are taken from FAO 26/2 and are derived from the national practices of the USSR
and USA.

Access for maintenance and cleaning is difficult or impossible with small diameter pipes. In these cases it
is important that the water is debris-free and carrying little sediment. A pipe velocity of 0.8 m/s should
make the structure self-cleaning.

Well Type Entry Structure (USSR)

Inlet and outlet structures (Figure 24) are of reinforced concrete whilst the pipes are 1.0 metre long, pre-
cast concrete spigot and socket type, with joints of bitumen-impregnated mineral wool and cement mortar.
The structure is equipped with a trash screen to prevent blockage of the pipe by floating debris.

Pipe diameter is 0.6 metres. Drop height is up to 2.5 metres and permissible discharges range to 1.4 m%/s.
USBR Structure

The USBR structure (Figure 25) is suitable for falls up to 4.5 metres. It has a closure gate at the upstream
end. Standard designs are available in a huge range of pipe sizes and drops. Discharges up to 1300 I/sec
can be accommodated by Type 1 structures. No upper limit is quoted for Type II structures which include
a formal hydraulic jump or baffle-type dissipating device at outlet.

4.6 Flow Expansion Structures and Downstream Protection
USBR Plunge Basin Energy Dissipator

Figure 26 shows a USBR detail for a plunge basin energy dissipater at a conduit outlet. The structure is for
use where the jet discharges freely into the air and then plunges into the basin. Tests have shown that if the
angle of impingement is too flat the jet will skip across the surface at high velocity and the structure
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becomes ineffective. Firm criteria for plunge pools have yet to be established. The figure is based on a
number of small outlet works plunge pools, which have operated satisfactorily. The basin depth was made
about one fifth of the static head between maximum upstream level and maximum tailwater level. The
minimum bottom width is equal to the width of the incoming jet, or that required to limit the average
velocity at the end of the basin to about 0.9 metres per second.

Dept. of Irrigation and Drainage - Malaysia

Empirically developed flow-expansion channel geometry is used downstream of regulating structures by
the DID, Malaysia. It is aimed to pre-form a protected shape, which approximates to that of a naturally
developed scour hole. The structure is termed an onion because of its shape, but formal recommendations
as to the ratio of width to depth and plan shape are not established. The structures were developed to
combat erosion that regularly developed downstream of the bed and bank protection layers which were
used for regulators. Figure 27 shows a typical arrangement.

Bed and Bank Protection

Standard protection details to bed and channel banks are provided with the principal references for most of
the standard structures referred to.

A common rule of thumb is to provide protection for a distance equal to four times the downstream depth
beyond the end of the solid apron. Bos (1989).

A flexible protection, either loose stone pitching or gabions, is preferable to a rigid protection such as
mortared stone pitching. Flexible armouring can not only deform to follow the profile of the channel bed
but is also more effective in dissipating energy. A rigid protection is sometimes adopted to avoid material
being stolen.

5. SELECTING A STRUCTURE

It is important that designers have a good understanding of basic hydraulics so that the structures they
choose are appropriate to the local hydraulic conditions.

The first part of the package allows designers to analyse the way in which simple straight drop and inclined
fall structures function in given hydraulic conditions. In theory, a basic design could be created from
scratch. The flow chart (Figure 28) shows the steps in analysis.

In practice, a very large number of standard designs have been developed throughout the world. Provided
that a particular national or regional design is hydraulically effective, durable and economic to construct
and maintain, there is no reason to resort to other designs. Section 4 gives designers an overview of a
number of common structures and the Standard Design module of DROP contains more details.

Designers may wish to review whether a standard design is suitable to given conditions.

Hydraulic jump stilling basins are extremely versatile structures, used over a very wide range of levels
downstream of spillways, weirs, chutes and flumes.

Straight drops in their simplest form, are extended hydraulic jump devices. A variant uses a “water
cushion” which operates more like a plunge pool (Section 4.6). Straight drops are most commonly used
for dissipating head below weirs, in small canal falls and in soil conservation practice. Solid foundation
material is necessary when the head exceeds about 2 metres because the falling jet imposes considerable
dynamic loading on the floor of the structure.
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Baffled outlets are commonly used with pipes, either for pipe drops in canal systems or at outlets from
dams, canal wasteways and cross drainage.

According to the USBR, the impact-type of energy dissipator is more efficient than the hydraulic jump
type and the use of this method in small canal applications will result in a smaller and more economical
structure.

Factors other than hydraulics and cost which will influence the selection of a structure are:

— Relative availability of particular construction materials and skills

— Quantity of sediment, trash and weeds transported by the flow

— Requirement or otherwise for road crossings

— Human health. Ponded water can encourage the breeding of disease vectors

Where alternative structures would be equally effective, cost will probably be the determining factor.

The flow chart, Figure 29, has been drawn-up to assist in making selections. The primary selection criteria
is hydraulic adequacy: many standard designs have been developed for a limited range of conditions. Use
of the structure in circumstances beyond those in which it has been tested is inadvisable and potentially
risky. The structure should be suited to both the anticipated discharge and the height of the fall: excessive
discharge can reduce the efficiency of energy dissipation, and excessive fall can produce structural
problems, inefficient hydraulic performance, and the danger of seepage, uplift and undermining.

The selection procedure distinguishes between structures involving drops of more than 4.5 metres — for
which nowadays concrete would usually be the material of choice and USBR designs, are available — and
smaller structures.

Particularly with smaller structures it may be practical and economic to combine a drop with a road or
pedestrian/animal crossing. A pipe drop may be indicated. Flumes, pipe drops and the SAF stilling basin
are all suited to relatively small discharges at heads up to at least 4.5 metres. If the structure is to be used
where the tailwater level cannot be assured, as in drainage and conservancy applications, structures such as
the USSCS drop with blocks are suitable. In some circumstances, particularly in Africa, ponded water can
potentially cause problems for human health (notably, schistosomiasis). Special designs, such as the free-
draining structure used in Zimbabwe, which was developed at HR Wallingford (Bolton, 1989), have been
developed specifically to reduce the potential for water-borne disease transmission. Small drops in
masonry may be the most economic and practical options in many regions.
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Figure 20 USBR Check Drop Structure (1 gate)
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Figure 21 USBR Check Drop Structure (2 gates)
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Figure 23 USBR Baffled Apron Drop
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Figure 24 USSR Pipe Drop (after FAO)
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Figure 25 USBR Pipe Drop with Concrete Transition
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Figure 26 USBR Plunge Basin Energy D
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Figure 29 Selecting a type design
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Appendix 1 The DROP program

Al A Rapid Guide to DROP
When you first start the DROP program you will see a line diagram showing the basic features of a straight
drop. You can go on to detail a similar structure or opt to analyse an inclined drop.

The program is structured to allow users to undertake various related tasks:

1.1 Analysis

A simple straight drop or an inclined structure can be defined and subjected to initial checks for
suitability in given hydraulic conditions. Relevant hydraulic parameters are calculated and may be
viewed graphically or printed out.

1.2 Design — Special
The outline structure sketched in the Analysis Module can be designed and dimensioned against
hydraulic criteria and modified as necessary to resist seepage.

1.3 Design — Standard

A decision tree allows users to select from a number of type designs drawn from world practice, to
suit hydraulic and other, more general criteria. A line diagram of each type is presented. Design
graphs, tables or formulae are provided to allow the user to select a suitably dimensioned structure.

Successive steps in the design process, summaries of leading results, and line diagrams can be printed or
plotted throughout the design development process.

A2 Basic Operations

DROP runs under DOS but it is written to appear as much as possible like a Windows-based program with
extensive use of pull-down menus and push buttons. The program will run on an IBM compatible PC with
a 386 SX central processor running DOS 5.0 or later.

If you normally work within Windows 3.1 or Windows 95 you can run DROP from a DOS window. If
you encounter problems due to memory allocation close Windows and run DROP directly from the DOS
prompt. If you want to use a mouse to move around the menus you must ensure that the mouse driver is
loaded before running DROP.

The menus and buttons can be accessed using either the mouse pointer or the keypad.

Pull-down menus Access these from the main menu headings using a single click of the left mouse
button or press the relevant ‘quick key’ — indicated by the underlined letter.

A menu option can be selected by:

e  Clicking twice with the left mouse key

e Move the highlight with the Up and Down arrows and press [Return]
e  Use of the ‘Quick key’ and [Return]

Push Buttons These can be operated by clicking on them twice with the left mouse button or by
the relevant function key, indicated on the button.

Use the on-line Help -> Interface menu for more information.

A HR Wallingford 6 OD/TN 86 01/07/02 11:43
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On-line Help

The program provides extensive on-line technical help. General help relating to the user interface and the
scope of the program is available from the main Help menu. Context-sensitive help is also available
throughout the program. Help buttons, marked ‘2 are provided beside every text data field. Use the
buttons to obtain help relating to each specific data field. Help relating to any specific window is obtained
by selecting the HELP button or F1. This calls up a three-item menu:

Interface: Goes to the general Help on the interface

Window: Explains the purpose of the data requested

Technical: At some points, additional technical explanation of data or results is
provided.

A.3  File
Provides menu options to open a new or existing project file, save changes to disk and exit from the
program.

3.1 New

Input parameters, results and graphics which are generated each time you use DROP are held in a
number of files with different extensions but with the same prefix or ‘Project’ name. The New
menu sets up a new set of empty project files. If you have made any changes to the “untitled’
Project, which is opened when you first open DROP, you are asked if you want to save that Project
before opening a new one.

3.2 Open

Displays a file listing and gives access to the directory structure so that you can open a Project file
that has been saved previously. Opening of a project file automatically overwrites the project that
is on screen. If this has been modified at all you are prompted to save it before opening another.

3.3 Save
Saves a previously named project. When you are working on a new DROP project, you must use
the Save As option the first time you save it.

34 Save As
Allows you to save a Project under a new file name. You must use this option when you first name
a Project file.

35 Exit

Leaves the DROP program and returns you to the DOS prompt. If you have made changes to the
Project that have not been saved you are asked if you want to save them before closing the
program.

A4 Analysis

Once the basic parameters for the height of the drop, channel sections and discharge range have been
defined, depth:discharge relationships can be developed for the upstream and downstream channels.
Calculation of the relationship for the upstream channel is straight forward; for the down stream channel it
may be necessary to allow for a change in the channel invert level over time owing to a general
degradation or accretion. The USBR recommends allowing for a 10% drop in the assumed tailwater level.
It is also important to consider the possibility that the development of the tailwater may lag behind the
build-up in the head water level, particularly in regions experiencing flash floods or in systems including
control gates and siphons
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Some types of structure, those that depend on a hydraulic jump for energy dissipation, require an adequate
tailwater for satisfactory operation. Others, such as the straight drop with impact blocks and the baffled
structures of the USBR, can operate almost independently of the tailwater level.

The width of the control section must be defined. In systems where trapezoidal canal sections are the norm
it is common practice to make the width of the crest of a straight drop equal to the channel bed width.
Upstream and downstream transitions are needed to pass the flow into and out of the structure. With
chutes, the throat width is commonly less than the bed width, but to avoid problems, such as cross-waves
which can develop with an excessive contraction ratio, it is normally limited to a minimum of about 60%.

After dimensions are defined, the Analysis Module tests for data consistency and the possibility of
upstream afflux. When the defined drop passes the tests for consistency, hydraulic analysis of the structure
can be carried out. This provides input data for the Special Design Module, (see Section 6.2).

4.1 Modify Flow Range
The maximum flow is used to calculate the maximum normal flow depth in the upstream and
down stream channel sections when their dimensions are defined in the subsequent menu options.

Very small flows have no influence on the design, the program expects a minimum flow not
greater than 10% of the maximum.

4.2 Modify Upstream
Allows the upstream channel section to be defined. Six possible cross-sectional shapes are
possible:

Rectangular

Trapezoidal

Complex trapezoidal, i.e. different side slopes on left and right bank
Double trapezoidal, i.e. central channel with berms

V shape

U shape

A sketch of the channel section shows the shape of the section in correct proportions. When you
change the shape of the section, using the Shape button, the sketch is removed. Use Test to re-
draw the section and re-calculate the normal flow depth and channel top width. If you want to see
the effect of changing the dimensions of an existing section you should use Test, as the sketch is
not automatically updated unless you exit from the window.

Compare the channel depth and the depth of normal flow, shown at the bottom left of the screen,
and ensure that the channel provides adequate freeboard.

4.3 Modify Downstream
Operates in the same way as the menu for the upstream section.

4.4 Modify Structure
The following parameters can be varied:

. type — vertical or inclined
o Shape of the inlet wing walls
. Shape of the outlet wing walls.

Select these parameters by highlighting the relevant dialogue box and using the Left and Right
arrow keys. Once definition is completed, press OK. A second window is opened to specify the
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width of the control section, the drop height and the glacis slope, in the case of an inclined drop. A
dimensioned line diagram on the screen summarises the structure.

4.5 Test
This tests for data consistency and warns if upstream afflux will occur. A message is displayed to
tell you to change the control section width if the structure fails the test.

4.6 Calculate
Runs the analysis calculations for the defined drop and channel conditions. The calculations

cannot be run until ‘Test’ has been satisfactorily completed.

View

The View menu provides a range of options to view graphically, or in tabular form, the inputs to and
outputs from, the Analysis module.

A.6

5.1 Diary

The diary displays a log of all the operations performed on the project file since its creation
including the results from any calculations carried out. It includes work done in both the Analysis
Module and the Design Module. Use the Help->Technical menu from the Diary window for
more information on how to use the diary function.

5.2 Results Tables
The table lists the results from the Analysis Module.

5.3 Results Graphs

Select the type of information that you want to plot. Move the highlight bar with the Up and
Down arrows or by pointing with the mouse. To display the graph, select OK or use the F 10 key,
which removes the data selection window and displays the graph on the screen.

Select, (F 6):  Returns you to the data selection window

Close, (F 7):  Returns you to the opening screen with the plan and sectional view of the drop and
main menu.

Grid, (F 8): Displays grid lines.

Print, (F 2):  If your computer is connected to a printer and you have set up the printer driver
correctly under the Options menu you can print the graphics output.

Plot, (F 3) If your computer is connected to a plotter and you have set up the driver correctly
under the Options menu you can send the graphics output to a colour plotter.

5.4 Tailwater Case

This presents a graph of tailwater and sequent depth against discharge for the channel and drop
dimensions defined in the Analysis Module. The graph is presented together with curves for five
‘standard’ cases. A comment at the lower right of the screen shows which case applies for the
defined conditions. The buttons Case 1 to Case 5 can be used to display text describing the five
cases.

5.6 Structure Parameters
This displays a summary of the drop and channel dimensions defined in the Analysis Module.

Design

The design module offers two sub-modules — Standard and Special. At present neither of the options can
be run until the Analysis Module has been completed and results generated, although the results of analysis
are only used as an input to the Special Design process.
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If you carry out a Special Design and then wish to run the Standard Design routine you should first save
the results of the special design using the File-> Save As menu before running the Standard Design as this
overwrites the output from the Special Design Module.

6.1 Standard

Standard Design takes you through a question and answer session to select from a number of
standard drop designs the type most suited to your specific application. The Yes and No buttons
are used to answer the questions. If you wish to change your response at any time, you can work
back to the relevant question using the Go Back button. When a design type is selected a drawing
is displayed which can be printed or viewed in more detail using the Zoom facility. Tables, graphs
or equations for selecting models within a range are included.

6.2 Special

The design steps presented to the user will vary, depending on the type of drop considered —
inclined or vertical. The Special Design Module takes a number of parameters, including the drop
type, from the Analysis Module.

6.2.1 Special Design for Inclined Drops
The program brings information from the Analysis Module to guide definition of the basin depth
and length.

Bed Degradation: For small structures general degradation of the downstream bed is not likely
except for very steep systems and therefore you should set Degradation = 0. If in doubt, set the
Degradation equal to 10% of down stream depth, Y.

Basin Depth Dy: Rules for setting the basin depth are included in the manual and on-line Help.
The basin depth is set so as to compensate for mismatches between the tailwater and sequent
depths.

If the tailwater depth exceeds requirements you will get the following message:
“Tailwater depth exceeds requirements by x m. Confirm OK or reduce basin depth Db.”

You can only reduce the basin depth if the existing design has a lowered basin floor. Otherwise
say “OK” and the basin floor will be set at the channel bed level.

If the tailwater depth is insufficient the message is:

“Tailwater depth is insufficient: set basin floor x m below nominal bed level or increase
tailwater.”

You must set the basin depth at or greater than the value specified before the program will allow
you to continue. You are prompted to check the tailwater and sequent depths at other discharges.
To do this, set the value in the Percent of Maximum Flow data field to a value less than 100 and
press Return. Values for the flow, tailwater depth and the sequent level will be updated and
illustrated on the graph.

Do not use the OK or F 10 key until you wish to move on to the next design stage, which will
set the basin length.

Once the basin depth is adequate set the basin length to lie in the range 70 — 100% of the jump
length.
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Check for Seepage: Rules for selecting cut-off depth and structure length are included in the
context-sensitive help. Once the structure is safe against seepage the leading dimensions are
summarised and the pressures at principal points are calculated. The pressures may be used in
subsequent structural design to ensure that the structure is protected against uplift.

6.2.2. Special Design for Vertical Drops

You can choose between a hydraulic jump basin and the (shorter) impact block basin. Apart from
savings in construction costs the latter is more suitable for high tailwater conditions. The tailwater
conditions can be reviewed using the TW Case option. Although the tailwater depth is
conventionally not taken as a limiting condition in the design of vertical drops, it is recommended
that for the hydraulic jump basin you aim to ensure that tailwater depth and sequent depth are not
widely divergent at the design maximum discharge.

There is no routine for setting the basin depth. The basin floor is normally set at, or close to, the
downstream bed level. A small end sill is normally used in the hydraulic jump basin, together with
small blocks to stabilise the jump. They are not shown in the line sketch but are shown in the
drawings presented under the Standard Design module.

Basin length and cut-off depth are set according to the hydraulic and seepage criteria as for
inclined drops.

Print

This sends a screen dump of the plan and elevation of the drop structure to the printer. To print data or
graphics from other windows you must use the Print button associated with that window.

A.8

A9

Note:

Options

8.1 Printer

The five printer options offered in the printer selection window are defined in the DROP code and
cannot be added to by the user. You should experiment with these different drivers until you find
the best match for your printer. Selection of the different resolutions adjusts the size of the output
on the page.

8.2 Plotter
The program provides three generic plotter drivers. The pen selection and colour assignment are
pre-defined for each driver and these are displayed when the driver is selected.

Help

9.1 Interface

Provides an indexed summary of information on the program interface, i.e. the screen display and
how to carry out the basic operations required to run the program.

9.2.1 Program
Provides a brief summary of the program and each of the main menu headings.

9.2.2 About Drop
This section gives the version number and acknowledges the copyright holders for the DROP
program.

Reference to Tables in Figures 13 — 26 reflects output from
the DROP program.
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